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This chapter provides information on the purpose of the manual, safety information, and additional
documents and resources.

Purpose 7

Combitronic Technology 7

I/O Device CAN Bus Controller 7

Safety Information 8

Safety Symbols 8

Other Safety Considerations 8

Motor Sizing 8

Environmental Considerations 8

Machine Safety 9

Documentation and Training 9

Additional Equipment and Considerations 10

Safety Information Resources 10

Additional Documents 10

Related Guides 11

Other Documents 11

Additional Resources 11

Moog Animatics Class 5 SmartMotor™ Installation and Startup Guide, Rev. M

Page 6 of 76



Purpose

Purpose
The Class 5 SmartMotor™ Installation and Startup Guide (the document you are currently reading) provides
an overview of the Class 5 SmartMotor, along with information on unpacking, installation and start up. This
guide is meant to be used in conjunction with the SmartMotor™ Developer's Guide, which describes the
SmartMotor features, SMI software, programming, commands, and other topics related to SmartMotor
application development.

The information in this guide is meant to be used by properly trained technical personnel only. Moog
Animatics conducts classroom-style SmartMotor training several times per year, as well as product
seminars and other training opportunities. For more information, please see the Moog Animatics website or
contact your Moog Animatics representative.

Combitronic Technology

The most unique feature of the SmartMotor is its ability to communicate with other SmartMotors and share
resources using Moog Animatics’ Combitronic™ technology. Combitronic is a protocol that operates over a
standard CAN interface. It may coexist with either the CANopen or DeviceNet protocols. It requires no
single dedicated controller1 to operate. Each SmartMotor connected to the same network communicates
on an equal footing, sharing all information, and therefore, sharing all processing resources.

For additional details, see the SmartMotor™ Developer's Guide.

I/O Device CAN Bus Controller

Expanded I/O capability allows the SmartMotor to interface with standard CiA 301 CANopen devices and
function as the I/O device CAN bus controller (i.e., no external bus controller is needed). For more details,
see the SmartMotor™ Developer's Guide. For CANopen object descriptions, see the SmartMotor™
CANopen Guide.

CANopen

ABS Encoder

Be sure to comply with the guidelines for CAN bus cabling and termination.

CANopen Valve Block

CANopen

REMOTE I/O

Without data collision!
TM

Motor to MotorMotor to I/O®

SmartMotor as I/O Device CAN Bus Controller

1Moog Animatics has replaced the terms "master" and "slave" with "controller" and "follower", respectively.
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Safety Information

Safety Information
This section describes the safety symbols and other safety information.

Safety Symbols

The manual may use one or more of these safety symbols:

WARNING: This symbol indicates a potentially nonlethal mechanical hazard, where
failure to comply with the instructions could result in serious injury to the operator or
major damage to the equipment.

CAUTION: This symbol indicates a potentially minor hazard, where failure to comply
with the instructions could result in slight injury to the operator or minor damage to the
equipment.

NOTE: Notes are used to emphasize non-safety concepts or related information.

Other Safety Considerations

The Moog Animatics SmartMotors are supplied as components that are intended for use in an automated
machine or system. As such, it is beyond the scope of this manual to attempt to cover all the safety
standards and considerations that are part of the overall machine/system design and manufacturing safety.
Therefore, this information is intended to be used only as a general guideline for the machine/system
designer.

It is the responsibility of the machine/system designer to perform a thorough "Risk Assessment" and to
ensure that the machine/system and its safeguards comply with the safety standards specified by the
governing authority (for example, ISO, OSHA, UL, etc.) for the site where the machine is being installed
and operated. For more details, see Machine Safety on page 9.

Motor Sizing

It is the responsibility of the machine/system designer to select SmartMotors that are properly sized for the
specific application. Undersized motors may: perform poorly, cause excessive downtime or cause unsafe
operating conditions by not being able to handle the loads placed on them. The System Best Practices
document, which is available on the Moog Animatics website, contains information and equations that can
be used for selecting the appropriate motor for the application.

Replacement motors must have the same specifications and firmware version used in the approved and
validated system. Specification changes or firmware upgrades require the approval of the system designer
and may require another Risk Assessment.

Environmental Considerations

It is the responsibility of the machine/system designer to evaluate the intended operating environment for
dust, high-humidity or presence of water (for example, a food-processing environment that requires water
or steam wash down of equipment), corrosives or chemicals that may come in contact with the machine,
etc. Moog Animatics manufactures specialized IP-rated motors for operating in extreme conditions. For
details, see the Moog Animatics Product Catalog.
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Machine Safety

Machine Safety

In order to protect personnel from any safety hazards in the machine or system, the machine/system
builder must perform a "Risk Assessment", which is often based on the ISO 13849 standard. The
design/implementation of barriers, emergency stop (E-stop) mechanisms and other safeguards will be
driven by the Risk Assessment and the safety standards specified by the governing authority (for example,
ISO, OSHA, UL, etc.) for the site where the machine is being installed and operated. The methodology and
details of such an assessment are beyond the scope of this manual. However, there are various sources of
Risk Assessment information available in print and on the internet.

NOTE: The next list is an example of items that would be evaluated when performing the Risk
Assessment. Additional items may be required. The safeguards must ensure the safety of all personnel
who may come in contact with or be in the vicinity of the machine.

In general, the machine/system safeguards must:

l Provide a barrier to prevent unauthorized entry or access to the machine or system. The barrier must
be designed so that personnel cannot reach into any identified danger zones.

l Position the control panel so that it is outside the barrier area but located for an unrestricted view of
the moving mechanism. The control panel must include an E-stop mechanism. Buttons that start the
machine must be protected from accidental activation.

l Provide E-stop mechanisms located at the control panel and at other points around the perimeter of
the barrier that will stop all machine movement when tripped.

l Provide appropriate sensors and interlocks on gates or other points of entry into the protected zone
that will stop all machine movement when tripped.

l Ensure that if a portable control/programming device is supplied (for example, a hand-held
operator/programmer pendant), the device is equipped with an E-stop mechanism.

NOTE: A portable operation/programming device requires many additional system design
considerations and safeguards beyond those listed in this section. For details, see the safety
standards specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the site
where the machine is being installed and operated.

l Prevent contact with moving mechanisms (for example, arms, gears, belts, pulleys, tooling, etc.).

l Prevent contact with a part that is thrown from the machine tooling or other part-handling equipment.

l Prevent contact with any electrical, hydraulic, pneumatic, thermal, chemical or other hazards that
may be present at the machine.

l Prevent unauthorized access to wiring and power-supply cabinets, electrical boxes, etc.

l Provide a proper control system, program logic and error checking to ensure the safety of all
personnel and equipment (for example, to prevent a run-away condition). The control system must
be designed so that it does not automatically restart the machine/system after a power failure.

l Prevent unauthorized access or changes to the control system or software.

Documentation and Training

It is the responsibility of the machine/system designer to provide documentation on safety, operation,
maintenance and programming, along with training for all machine operators, maintenance technicians,
programmers, and other personnel who may have access to the machine. This documentation must
include proper lockout/tagout procedures for maintenance and programming operations.

It is the responsibility of the operating company to ensure that:
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Additional Equipment and Considerations

l All operators, maintenance technicians, programmers and other personnel are tested and qualified
before acquiring access to the machine or system.

l The above personnel perform their assigned functions in a responsible and safe manner to comply
with the procedures in the supplied documentation and the company safety practices.

l The equipment is maintained as described in the documentation and training supplied by the
machine/system designer.

Additional Equipment and Considerations

The Risk Assessment and the operating company's standard safety policies will dictate the need for
additional equipment. In general, it is the responsibility of the operating company to ensure that:

l Unauthorized access to the machine is prevented at all times.

l The personnel are supplied with the proper equipment for the environment and their job functions,
which may include: safety glasses, hearing protection, safety footwear, smocks or aprons, gloves,
hard hats and other protective gear.

l The work area is equipped with proper safety equipment such as first aid equipment, fire
suppression equipment, emergency eye wash and full-body wash stations, etc.

l There are no modifications made to the machine or system without proper engineering evaluation for
design, safety, reliability, etc., and a Risk Assessment.

Safety Information Resources

Additional SmartMotor safety information can be found on the Moog Animatics website; open the topic
"Controls - Notes and Cautions" located at:

https://www.animatics.com/support/downloads/knowledgebase/controls---notes-and-cautions.html

OSHA standards information can be found at:

https://www.osha.gov/law-regs.html

ANSI-RIA robotic safety information can be found at:

http://www.robotics.org/robotic-content.cfm/Robotics/Safety-Compliance/id/23

UL standards information can be found at:

http://ulstandards.ul.com/standards-catalog/

ISO standards information can be found at:

http://www.iso.org/iso/home/standards.htm

EU standards information can be found at:

http://ec.europa.eu/growth/single-market/european-standards/harmonised-standards/index_en.htm

Additional Documents
The Moog Animatics website contains additional documents that are related to the information in this
manual. Please refer to these lists.
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Related Guides

Related Guides
l Moog Animatics SmartMotor™ Installation and Startup Guides

http://www.animatics.com/install-guides

l SmartMotor™ Developer's Guide

http://www.animatics.com/smartmotor-developers-guide

l SmartMotor™ Homing Procedures and Methods Application Note

http://www.animatics.com/homing-application-note

l SmartMotor™ System Best Practices Application Note

http://www.animatics.com/system-best-practices-application-note

In addition to the documents listed above, guides for fieldbus protocols and more can be found on the
website: https://www.animatics.com/support/downloads.manuals.html

Other Documents
l SmartMotor™ Certifications

https://www.animatics.com/certifications.html

l SmartMotor Developer's Worksheet
(interactive tools to assist developer: Scale Factor Calculator, Status Words, CAN Port Status, Serial
Port Status, RMODE Decoder and Syntax Error Codes)

https://www.animatics.com/support/downloads.knowledgebase.html

l Moog Animatics Product Catalog

http://www.animatics.com/support/moog-animatics-catalog.html

Additional Resources
The Moog Animatics website contains useful resources such as product information, documentation,
product support and more. Please refer to these addresses:

l General company information:

http://www.animatics.com

l Product information:

http://www.animatics.com/products.html

l Product support (Downloads, How-to Videos, Forums and more):

http://www.animatics.com/support.html
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Additional Resources

l Contact information, distributor locator tool, inquiries:

https://www.animatics.com/contact-us.html

l Applications (Application Notes and Case Studies):

http://www.animatics.com/applications.html
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SmartMotor Overview

SmartMotor Overview
This chapter provides an overview of the design philosophy and functionality of the Moog Animatics
SmartMotor. It also provides information on SmartMotor features and options, and where to find related
documents and additional resources.
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SmartMotor Introduction

SmartMotor Introduction
The Moog Animatics SmartMotor™ servo is an industrial servo motor with motion controller integrated into a
compact package. Its design is based on these objectives:

1. Reduce development time

2. Lower machine-production cost

3. Simplify the machine (design, build and support)

Class 5 D-Style Cast and Extruded SmartMotors

NOTE: Information in this guide applies to both the cast and extruded motors.

M-Style SmartMotors
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SmartMotor Features and Options

The SmartMotor is powerful and unique because of its ability to control an entire machine. The combination
of programmability, networking, I/O and servo performance is unmatched. The SmartMotor brings savings
and value to the machine builder by removing complex and costly elements in the machine design, such as
PLCs, sensors, I/O blocks, cabinets, etc.

SmartMotor Features and Options
NOTE: All specifications are subject to change without notice. Consult the factory for the latest
information.

The Class 5 SmartMotor is available in D-style and M-style configurations. All SmartMotors offer these
features:

l Full floating-point math and trigonometric functions with 32-bit precision results

l Dual trajectory generators enabling relative and absolute position moves or velocity moves on top of
gearing or camming

l Advanced gearing allowing preset traverse and take-up winding parameters including dwells and
wrap counts

l Advanced camming including cubic spline interpolation and dynamic frequency and amplitude
changes. Add onto gearing for complex traverse and take-up winding patterns.

l Stand-alone, multi-axis linear interpolation with as many as 120 SmartMotors at a time

l Virtual-axis control into camming through gearing, which enables stand-alone, multi-axis
coordinated motion

l Programmable and non-programmable protection features (both hardware and software)

The next sections describe the similarities and differences between the D-style and M-style configurations.

A note about SmartMotor part numbers:

The SmartMotor uses a coded part number, which contains characters that describe the motor number,
frame style and options. For details on decoding the SmartMotor part number, refer to the Understanding
SmartMotor Part Numbers document at this address:

https://www.animatics.com/support/downloads.knowledgebase.html

D-Style Motors

All D-style SmartMotors have:

l A primary RS-232 communications port

l A secondary RS-485 communications port

l Seven channels of 5 VDC TTL non-isolated I/O

l Ten optional channels of expanded 24 VDC isolated I/O

l A dedicated, single-ended encoder output

These industrial (Fieldbus protocol) communications options are available on the D-style motors.
(Availability varies by model number; contact the factory for details.)

l CANopen option

l PROFIBUS option

l DeviceNet option
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M-Style Motors

For more details, see Fieldbus Options on page 17.

All firmware options include:

l Modbus Remote Terminal Unit (RTU) Follower (RS-485 COM 1)

l DMX Follower (RS-485 COM 1)

In addition, a hardware DE power option is available, which allows the controller and drive amplifier to be
powered from separate power sources. For more details, see DE Option (D-Style Motors) on page 20.

CAUTION: For D-style SmartMotors, pins 14 and 15 of the 15-pin D-sub port are
intended for use with DE series motors for control power only. Attempts to power a
non-DE motor through those pins as main servo drive power could result in immediate
damage to the electronics and will void the warranty.

The D-style motors are available in these NEMA frame sizes:

l NEMA 17

l NEMA 23

l NEMA 34

The next figure shows the connector and LED locations for the D-style motors. For details on the D-style
motor connectors, see D-Style Motors: Connectors and Pinouts on page 35. For details on the LED
functions, see Understanding the Status LEDs on page 48.

15-Pin D-Sub I/O

7-Pin Combo D-Sub 
Power & I/O

CAN Fault LED

CAN Status LED

CAN Connector

Expanded I/O Connector

Power/Servo LED

Trajectory LED

D-Style Motor Connectors and LEDs

M-Style Motors

All M-style SmartMotors have:

l A primary RS-485 communications port

l Eleven channels of general purpose 24 VDC isolated I/O

l A dedicated Drive-Enable Input and NOT-FAULT Output

l A dedicated differential ±5V encoder bus
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Fieldbus Options

These industrial (Fieldbus protocol) communications options are available on the M-style motors.
(Availability varies by model number; see the Moog Animatics Product Catalog for details.)

l CANopen option

l DeviceNet option

NOTE: The PROFIBUS fieldbus protocol is not available on the M-style motors.

All firmware options include:

l Modbus Remote Terminal Unit (RTU) Follower (RS-485 COM 0)

l DMX Follower (RS-485 COM 0)

In addition, a hardware DE power option is available, which allows the controller and drive amplifier to be
powered from separate power sources. For more details on the Fieldbus and DE options, see Fieldbus
Options on page 17 and DE Option (D-Style Motors) on page 20.

The M-style motors are available in these NEMA frame sizes:

l NEMA 23

l NEMA 34

The next figure shows the connector and LED location for the M-style motors. For details on the M-style
motor connectors, see M-Style Motors: Connectors and Pinouts on page 44. For details on the LED
functions, see Understanding the Status LEDs on page 48.

8-Pin COM Encoder Bus

CAN Fault LED

CAN Status LED

CAN Connector

12-Pin I/O Connector

Power/Servo LED

Trajectory LED

4-Pin Power Input

5-Pin Limit Inputs

M-Style Motor Connectors and LEDs

Fieldbus Options

This section details the Fieldbus communications protocol options that are available on certain models of
SmartMotors.
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CANopen Fieldbus Protocol

CANopen Fieldbus Protocol

NOTE: This protocol is available on D-style and M-style motors.

The CANopen fieldbus protocol provides these features:

l Basic motion commands available through the CiA V4.02 specification

l Ability to read/write SmartMotor variables

l Use of onboard I/O through CANopen, SmartMotor programs or serial commands

l Ability to run 1000 SmartMotor subroutines through CANopen

l Online diagnostics of the SmartMotor through SMI software and serial connection

l Logical addressing for 127 nodes

l User program status/interrupts can be triggered by receive PDOs

l Baud rates of 20 Kbps, 50 Kbps, 125 Kbps (default), 250 Kbps, 500 Kbps and 1 Mbps

l Expanded I/O capability allows the SmartMotor to interface with standard CiA 301 CANopen devices
and function as the I/O device CAN bus controller (i.e., no external bus controller is needed). For
more details, see the SmartMotor™ Developer's Guide. For CANopen object descriptions, see the
SmartMotor™ CANopen Guide.

The next figure shows the location of the CANopen port and the corresponding pinouts.

5-Pin CANopen Connector
(female is standard)

Not Connected
+V (not connected)
-V (ground)

CANopen Pinout:

NOTES:  
Pin 2 is not connected, except on DeviceNet systems.
Pin 3 is isolated on D-style motors and unisolated on M-style motors.
Male connector is an option on M-style motors.

CAN-H
CAN-L

M-Style D-Style

1
2
3
4
5

CANopen Connector Location and Pinouts

For more connector/pinout details, see Connecting the System on page 33

DeviceNet Fieldbus Protocol

NOTE: This protocol is available on D-style and M-style motors.

The DeviceNet Fieldbus protocol provides these features:
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PROFIBUS Fieldbus Protocol

l Polled I/O and Explicit Messages from your PLC to control all SmartMotor operation

l Read/write control over all Open DeviceNet Vendor Association (ODVA) position-controller
parameters

l Use of on-board I/O through DeviceNet, SmartMotor program or serial commands

l Ability to run 1000 SmartMotor subroutines through DeviceNet and read/write four 32-bit user
variables

l Online diagnostics of the SmartMotors through SMI software and serial connection

l Up to 64 DeviceNet nodes

l 250 microsecond interrupt-driven subroutine

l Baud rates of 125 Kbps, 250 Kbps and 500 Kbps (the default is 125 Kbps)

The next figure shows the location of the DeviceNet port and the corresponding pinouts.

5-Pin DeviceNet Connector
(female is standard)

Not Connected
+24V (connected)
-V (ground)
CAN-H
CAN-L

M-StyleM-Style

NOTES:  
Pin 2 is connected only on DeviceNet systems; input current < 10mA.
Pin 3 is isolated on D-style motors and unisolated on M-style motors.
Male connector is an option on M-style motors.

M-Style D-Style

DeviceNet Pinout:
1
2
3
4
5

DeviceNet Connector Location and Pinouts

For more connector/pinout details, see Connecting the System on page 33

PROFIBUS Fieldbus Protocol

The PROFIBUS fieldbus protocol provides these features:

l Command/Response Codes for all Class 5 SmartMotor commands

l Use of on-board I/O through PROFIBUS, SmartMotor program, or RS-232 commands

l Ability to run 1000 SmartMotor subroutines through PROFIBUS

l Ability to read/write all SmartMotor variables

l Online diagnostics of the SmartMotors through SMI software and RS-232 connection

l Up to 127 PROFIBUS nodes
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DE Option (D-Style Motors)

l 250 microsecond interrupt-driven subroutine

l Baud rates of 9.6 Kbps, 19.2 Kbps, 31.25 Kbps, 45.45 Kbps, 93.75 Kbps, 187.5 Kbps,
500 Kbps, 1.5 Mbps, 3 Mbps, 6 Mbps and 12 Mbps (the default is 1.5 Mbps)

The next figure shows the location of the PROFIBUS port on the D-style motor and the corresponding
pinouts.

SHIELD DRAIN,

HIGH IMPEDANCE

NC

BUS-B

RTS

GROUND

+5V

NC

BUS-A

NC

PROFIBUS Pinout:

1

2

3

4

5

6

7

8

9

9-Pin, D-sub PROFIBUS Connector

PROFIBUS Connector Location and Pinouts on D-Style Motor

For more details, see the Class 5 SmartMotor™ PROFIBUS Guide.

DE Option (D-Style Motors)

The D-style SmartMotor's hardware DE power option allows the controller and drive amplifier to be
powered from separate DC power supplies (see the next figure). For a schematic diagram, see DE Option
on page 38.

This option provides these advantages:

l Controller can be powered from a standard 24-48 power supply

l Position will not be lost if drive power is lost

l No need to re-home

l Load surges will not cause a power surge on the controller

l Standard battery options are made simpler

NOTE: All M-style SmartMotors are designed to allow the use of separate drive and control power
supplies. No special ordering option is needed for those SmartMotors.
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IP65 and IP67 M-Style Motors

The next figure shows the connectors used for the DE power option.

Control power supplied to this
connector (24-48 VDC)

Drive Amp power supplied to
this connector (24-48 VDC)

NOTE: The same power supply may be 
used for Control and Drive power, but 
maximum protection is provided with 
separate power supplies.

NOTE: These motors can operate on 
power down to +20 VDC, but it is not 
recommended due to greatly reduced 
performance — optimum perfor-
mance is achieved at 48 VDC.

D-Style DE Power Option Drive and Control Power Connections

IP65 and IP67 M-Style Motors

Certain models of M-style SmartMotors are available in IP-rated versions (see the Moog Animatics Product
Catalog for details). The standard IP rating is IP65, which protects the motor from dust particles and
splashing water. Additionally, certain motors can be ordered with the higher IP67 rating. Contact Moog
Animatics for details.

IP ratings are in accordance with the code defined in international standard IEC 60529. Instead of the
vague descriptions of "waterproof", "water-resistant" or "dustproof", the IP-rating system provides a
uniform, quantifiable set of standards to which each product is rigorously tested. The IP code refers to the
degree of protection for the electrical enclosures on a machine against liquid, solid objects and particulates.
The first number after "IP" refers to the level of protection of the hazardous parts and electrical enclosures
against solid objects and particulates, and the second digit indicates the level of water resistance. The
higher the first digit rating in the IP system, the smaller the foreign object that it is protected against.

SmartMotors with the IP65 rating are both completely dust tight and protected from ingress of liquid that
may occur from any angle (see CAUTION statement above), rendering no harmful effects on the electrical
enclosure. SmartMotors with the IP67 rating can be submersed in water or other non-hazardous liquids to a
depth of one meter for a maximum time of 30 minutes. Therefore, conditions with high levels of humidity
and condensation are no longer a problem. The IP-rated models provide the perfect integrated servo for
food and beverage manufacturing and packaging, rugged outdoor conditions, as well as any wet
environment.
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SmartMotor Theory of Operation

Note that there are special IP-rated cables, which are available from Moog Animatics, that are designed for
use with the IP-rated SmartMotors. The next figure shows the cables, part numbers and corresponding
connections.

NOTE: LED operation is the same as standard (non-IP rated) SmartMotors.

SM34165M/MT

PC/RS-232

CBLIP-LIM-FL (5 Pin)

CBLIP-PWR4-FL (4 Pin)

CBLIP-COM-FL (8 Pin)

Separate 24V Control Power

24V - 48V Drive Power 

1
2
3
4

RS232485T

CBLIP-IO-FL (12 Pin)

CBLIP-CAN-FL (5 Pin)

IP-Rated Cables and Connections

SmartMotor Theory of Operation
The Moog Animatics SmartMotor is an entire servo control system built inside of a servo motor. It includes a
controller, an amplifier and an encoder. All that is required for it to operate is power and either an internal
program or serial commands from outside (or both). To make the SmartMotor move, the program or serial
host must set a mode of operation, state a target position with/or a maximum velocity at which to travel to
that target, and a maximum acceleration. After these three parameters are set, the two limit inputs are
properly grounded or deactivated, and the Drive Enable input is satisfied (on M-style motors), a "Go"
command starts the motion profile.

The core functional areas of the SmartMotor are:

l Motion Control Functions (see Motion Details in the SmartMotor™ Developer's Guide)

l System Control Functions (see Program Flow Details and see System Status in the SmartMotor™
Developer's Guide)

l Communication Functions (see Communication Details in the SmartMotor™ Developer's Guide)

l I/O Functions (see I/O Control in the SmartMotor™ Developer's Guide)
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SmartMotor Theory of Operation

The next block diagram illustrates the relationship between the functional areas in the SmartMotor.
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1.  MFMUL and MFDIV commands do not have an effect on  dwell time or distance.  Dwell is strictly based on  raw controller encoder counts selected by the 

SRC( ) command  specifying internal virtual or external controller count source.

2.  When feeding a Cam table with a gearing profile, changes to MFMUL and MFDIV will affect the time it takes to move through a Cam table but will not 

affect dwell time, as specified in the previous note.
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SmartMotor Theory of Operation Diagram
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Getting Started

Getting Started
This chapter provides information on getting started with your SmartMotor.

Unpacking and Verifying Your Shipment 26

Installing the SMI Software 26

Installation Procedure 26

Installation Verification 29

Accessing the SMI Software Interface 29

Understanding the Power Requirements 31

SmartMotor Power Requirements 31

D-style CPU, I/O and Communications Power 32

CPU Power Requirements 32

I/O Power Requirements 32

Communications Power Requirements 32

M-Style CPU, I/O and Communications Power 32

CPU Power Requirements 32

I/O Power Requirements 32

Communications Power Requirements 33

M-Style Drive Enable Power 33

Connecting the System 33

Minimum Requirements 33

D-Style Motors: Connectors and Pinouts 35

D-Style Connections At A Glance 35

D-Style Motors: Demo or Development System 36

D-Style Motors: RS-232 Through USB 37

Adding a USB to Serial Adapter 37

D-Style Motors: RS-232 with Protective Shunt 37

D-Style Motors: RS-232 Multidrop with Add-A-Motor Cables 38

DE Option 38

D-Style Motors: CDS Option Schematic 39

CDS on the DA-15 Connector 39

CDS on the 7W2 Connector (CDS7) 40

M-Style Motors: Connectors and Pinouts 44

M-Style Connections At A Glance 44

M-Style Motors: Power, RS-485 Com and CANMultidrop 45

M-Style Motors: Power Multidrop 45

M-Style Motors: RS-232 to RS-485 Multidrop 46
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Getting Started

M-Style Motors: CANopen or DeviceNet Multidrop 47

Understanding the Status LEDs 48

Detecting and Addressing the SmartMotors 49

Understanding the Detection and Addressing Options 49

Using the Find Motors Button 50

Using the Detect Motors Feature 53

Using the Address Motors Feature 54

Checking and Clearing the Status Bits 56

Polling the Motor 58

Clearing the Overtravel Limits and Fault Bits 59

Moving the SmartMotor 60

Making the Motor Move 60

Setting and Reporting Torque 61

Checking the Motor Position 62

Viewing the Motor Position with a Report Command 62

Viewing the Motor Position with the Motor View Tool 62
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Unpacking and Verifying Your Shipment

Unpacking and Verifying Your Shipment
Your Moog Animatics SmartMotor and accessories are carefully assembled, tested, inspected and packed
at the factory.

When you receive your shipment, you should:

l Visually inspect all shipping containers for visible signs of shipping damage. If you see damage,
please notify your carrier and then contact Moog Animatics to report the problem.

l Carefully unpack each component and verify the part number with your order. If there are any
differences or missing items, please contact Moog Animatics so that the shipment can be corrected.

l Keep all boxes and packing materials. These may be needed for future storage or shipment of the
equipment.

Installing the SMI Software
The SmartMotor Interface software (SMI software) provides a convenient user interface for programming
the SmartMotor. Before you can use the SMI software, it must be installed on a Microsoft Windows PC.

The SMI software is distributed on CD-ROM or USB stick, and is also available as a download from the
Moog Animatics website. To download the latest version of the SMI software, use this address:

http://www.animatics.com/smi

Then scroll to the bottom of the page and click the Free Download button.

SMI Download Button

The installation package is downloaded to your system.

NOTE: The SMI software requires Microsoft Windows XP or later.

Installation Procedure

NOTE: Depending on the SMI software version and SmartMotor model being used, the software
version and motor information may be different on your screens.

To install the SMI software:
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Installation Procedure

1. Double-click the executable package (.MSI) file to begin the installation. In some versions of
Microsoft Windows, you may receive a security warning message about running the file. You can
ignore this message.

If this is a new installation, go to the next step.

If this is an upgrade to a previous installation, you will see the window below. Select Remove, click
Next and remove the existing software from your PC using the instructions.

After removing the existing software, restart the installation process.

NOTE: All personal settings and user files will be retained.

2. Click Next to proceed. The Installation Configuration page opens.
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Installation Procedure

3. Click Next to proceed. The SMI software installation wizard starts and the Welcome page opens.

4. After you have finished reviewing the welcome information, click Next to proceed. Use the on-screen
instructions to complete the SMI software installation.
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Installation Verification

5. When the installation has completed, the installation status message page opens, as shown in the
next figure. Click Finish to complete the installation and close the installation wizard.

NOTE: After the software is installed, be sure to restart your computer before running the SMI software.

Installation Verification

To verify the installation, navigate to the C:\Program Files (or folder C:\Program Files x86) folder. You
should see these folders:

Accessing the SMI Software Interface
The SmartMotor Interface software (SMI software) communicates with a single or series of SmartMotors
from aWindows-based PC and gives you the capability to control and monitor the status of the motors. The
SMI software also allows you to write programs and download them into the SmartMotor’s long-term
memory.

NOTE: Every SmartMotor has an ASCII interpreter built in. Therefore, it is not necessary to use the SMI
software to operate a SmartMotor.

To open the SMI software, double-click the SmartMotor Interface shortcut on the Windows desktop.

SmartMotor Interface Shortcut
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Accessing the SMI Software Interface

Optionally, to open the SMI software from the Microsoft Windows Start menu, select:

Start > All Programs > Animatics > SMI3 > SmartMotor Interface

The SMI software interface opens, as shown in the next figure.

Menu bar

Toolbar

Configuration
window

Terminal
window

Information
window

Program
editor

SMI Software Interface

NOTE: In addition to the software information in this section, there is context-sensitive help available
within the SMI software interface, which is accessed by pressing the F1 key or selecting Help from the
SMI software main menu.

These are the primary features in this interface:

l Menu Bar: All of the windows and functions of the SMI software can be accessed through the menu
bar. Many of these are also accessible through the icons on the toolbar.

l Toolbar: The toolbar contains a collection of icons for accessing the primary features of the SMI
software. Depending on the current state of the SMI software and the currently-active window, some
toolbar buttons may be disabled.

l Configuration Window (far-left window): This window is used to display the current communication
and detected motor configuration when no project is open, or the communication and motor
configuration defined in an open project.

l Terminal Window (middle window): This window is used to communicate with SmartMotors (for
example, issue single-line commands to one or all motors). The response (if any) is also shown in
this window.

l Information Window (lower window): This window is used to display the results of user operations.

l Program Editor (far-right window): This window is used to manage, edit and print user programs.
Most of the procedures for using the editor should seem familiar if you have used other Windows-
based text editors.

For more details about these items, see the SMI software online help, which can be viewed in SMI by
pressing F1 or selecting Help > Contents - SMI Software Help.
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Understanding the Power Requirements

Understanding the Power Requirements
This section describes the power requirements for SmartMotor power, CPU power, I/O power and
Communications power. For individual pin specifications, refer to Class 5 D-Style Connector Pinouts on
page 66, and Class 5 M-Style Connector Pinouts on page 69, for D-style and M-style, respectively.

SmartMotor Power Requirements

Requirement: The power range for D-style SmartMotors is from 24 VDC to 48 VDC; do not exceed 48
VDC. For the D-style AD1 option, do not exceed 24 VDC. Main power must be connected to a source
capable of supplying the rated power of the motor.

NOTE: These motors can operate on power down to +20 VDC, but it is not recommended due to greatly
reduced performance -- optimum performance is achieved at 48 VDC.

For M-style SmartMotors: Control power requires 24 VDC, do not exceed 24 VDC; motor power requires
from 24 VDC to 48 VDC, do not exceed 48 VDC.

CAUTION: Control power for M-style motors must be 24 VDC. They are not rated for
48 VDC.

Details: Some of the larger SmartMotors can draw high current. Therefore, heavy gauge wire is required to
connect the large motors. As a result, Add-A-Motor cables are only recommended for series 17 and 23
motor frames. Control power consumes much less current. The exact amount depends on I/O,
communication and brake usage, but it is generally under 300 mA. For more information, see the CPU, I/O
and Communications Power section.

Voltages below 18 VDC could cause a brownout shutdown of the CPU, or what would appear as a power-
off reset, under sudden load changes.

CAUTION: If power is reversed on any standard SmartMotor, immediate damage
WILL occur and the SmartMotor will no longer operate.

When relying on torque/speed curves, pay close attention to the voltage on which they are based.

During hard, fast decelerations, a SmartMotor can pull up supply voltages to the point of damage if a shunt
resistor pack is not used. Protective shunts are available from Moog Animatics.

Special care must be taken when near the upper voltage limit or in vertical applications that can back-drive
the SmartMotor. Gravity-influenced applications can turn the SmartMotor into a generator and back-drive
the power supply voltage above the safe limit for the SmartMotor. Many vertical applications require a shunt
to protect the SmartMotor from damage. Protective shunts are available from Moog Animatics.

CAUTION: Many vertical applications and applications with hard, fast decelerations
require shunts to protect the SmartMotor from damage. Note that shunts should
always be placed between the motor input and any disconnect or E-stop relay to
protect the motor when power is off or E-stop relay contacts are open.
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D-style CPU, I/O and Communications Power

D-style CPU, I/O and Communications Power

CPU Power Requirements

Requirement: Maximum of 5 VDC on any I/O pin or 5 VDC pin.

Details: D-style SmartMotors have an internal 5 VDC power supply to run the internal CPU. This supply can
be easily damaged if an external voltage source of a higher voltage potential is applied. Therefore, do not
exceed 5 VDC on any TTL-level I/O pin or 5 VDC pin.

I/O Power Requirements

Requirement: Maximum sink amperage = 25 mA; Maximum source amperage = 25 mA.

Details: Each on-board 5 V I/O pin has a minimum amount of protection consisting of a 100 ohm current-
limit resistor and a 5.6 VDC Zener diode. Each I/O pin also has a 5 kohm pull-up resistor. When assigned
as outputs, they act as a push-pull amplifier that drives hard to either the positive or negative 5 VDC rail.
This means they are not open-collector I/O pins. Each I/O pin can sink up to 25 mA and source up to 25 mA.
Exceeding this could result in damage to the I/O port.

The AD1 option on the D-series motor provides isolated 24 V I/O. The user must supply the 24 VDC at the
I/O power input (pin 11) on the round 12-pin connector.

CAUTION: For Class 5 D-style AD1 option motors, at no time should the voltage to
any input exceed the level on the I/O power input (pin 11). Doing so could cause
immediate damage to the expanded I/O hardware.

Communications Power Requirements

Requirement: Proper serial ground signal referencing and shielding techniques are required; do not use
the cable shield for the RS-232 ground reference.

Details: The D-style SmartMotor has a two-wire RS-232 port. This port meets IEEE standards with full
+/-12 VDC potential on the transmit line. Proper serial ground signal referencing and shielding techniques
must be used. Under no circumstances should the shield of a cable be used for the RS-232 ground
reference. This could result in noise or corrupt data as well as ground loops that could damage the serial
port chip set.

M-Style CPU, I/O and Communications Power

CPU Power Requirements

Requirement: Nominal 24 VDC (±20%) must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input () on the connector.

I/O Power Requirements

Requirement: Nominal 24 VDC (±20%) must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input () on the connector.

NOTE: This I/O is not isolated from the CPU's power supply and the motor drive.
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Communications Power Requirements

Communications Power Requirements

Requirement: Nominal 24 VDC (±20%) must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input () on the connector.

NOTE: The RS-485 signal is not isolated from the CPU's power supply or the motor drive.

M-Style Drive Enable Power

The Drive Enable input on the M-series motor must be connected and activated with 24V. For the input
location, see M-Style Motors: Connectors and Pinouts on page 44.

Connecting the System
The topics listed below show system connections and cable diagrams for typical D-style and M-style motor
installations. For connector specifications, I/O and Channel information, and example I/O connections, see
Connectors, Pinouts and Examples on page 65.

For D-style motors:

l D-Style Motors: Connectors and Pinouts on page 35
l D-Style Motors: Demo or Development System on page 36
l D-Style Motors: RS-232 Through USB on page 37
l D-Style Motors: RS-232 with Protective Shunt on page 37
l D-Style Motors: RS-232 Multidrop with Add-A-Motor Cables on page 38
l DE Option on page 38

For M-style motors:

l M-Style Motors: Connectors and Pinouts on page 44
l M-Style Motors: Power, RS-485 Com and CAN Multidrop on page 45
l M-Style Motors: RS-232 to RS-485 Multidrop on page 46
l M-Style Motors: CANopen or DeviceNet Multidrop on page 47

As you can see, many configurations are possible.

l If you are installing one of these typical configurations and Moog Animatics-supplied cables, simply
use the connection information in this section.

l If you are using your own cables or a non-typical configuration, review the information in this section
and also see Connectors, Pinouts and Examples on page 65.

Advanced communication information is available in Communication Details in the SmartMotor™
Developer's Guide.

Minimum Requirements

At minimum, you will need these items:

1. A Class 5 D-style or M-style SmartMotor

2. A computer running Microsoft Windows and the SMI software

3. A DC power supply and power cable for the SmartMotor
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Minimum Requirements

4. A data cable to connect the SmartMotor to the computer’s serial port or through a USB to serial
adapter, see D-Style Connections At A Glance on page 35.

OR a USB cable to connect the SmartMotor to the computer's USB port, see Connecting the
System on page 33,

OR if your SmartMotor is equipped with the Ethernet option, a Cat 5 (or better) Ethernet cable to
connect the motor to the computer's Ethernet port, see Connecting the System on page 33.
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D-Style Motors: Connectors and Pinouts

D-Style Motors: Connectors and Pinouts

The next figure provides a brief overview of the connectors and pinouts available on the D-style
SmartMotors. For full details, see Class 5 D-Style Connector Pinouts on page 66.

PIN

1

2

3

4

5

NC

+V (NC except DeviceNet)

-V (Isolated GND, not common )

CAN-H

CAN-L

DESCRIPTION

5-Pin CAN (female) 

1

2

3

4

5

6

7

8

9

10

11

12

I/O-16 GP

I/O-17 GP

I/O-18 GP

I/O-19 GP

I/O-20 GP

I/O-21 GP

I/O-22 GP

I/O-23 GP

I/O-24 GP

I/O-25 GP

+24VDC Input

GND I/O (not common)

PIN DESCRIPTION

12-Pin Expanded I/O Connector
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

I/O-0

I/O-1

I/O-2

I/O-3

I/O-4

I/O-5

I/O-6

Encoder A Out

Encoder B Out

RS-232 Transmit

RS-232 Receive

+5VDC Out

Common Ground

(typ. SIG Ground)

Common Ground

Power

PIN DESCRIPTION

7-Pin Combo D-Sub Power & I/O

A1 A2
1  2

3 4 5

A1

A2

1

2

3

4

5

+20V to +48V DC

Common Ground

(req’d. POWER Ground)

I/O-6

+5VDC Out

RS-232 Transmit

RS-232 Receive

Common Ground 

(typ. SIG Ground)

PIN DESCRIPTION

15-Pin D-Sub I/O

Trajectory LED

PWR/Servo LED

CAN Fault LED

CAN Status LED

 15  14  13  12  11  10   9 

 

 

   8    7    6     5    4    3    2    1  

NOTE: The DE power option is recommended. For details, see DE Option on page 38.

CAUTION: The 12-Pin Expanded I/O and the 5-Pin CAN connectors must be finger
tightened only! DO NOT use a wrench or other tool. Doing so can cause
overtightening of the connection, which may damage the connector and will void the
warranty.

CAUTION: For Class 5 D-style AD1 option motors, at no time should the voltage to
any input exceed the level on the I/O power input (pin 11). Doing so could cause
immediate damage to the expanded I/O hardware.

D-Style Connections At A Glance

The next figure provides a quick overview of the cables and connections for the Class 5 D-style motor.
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D-Style Motors: Demo or Development System

CBLSM1-xM

PS24V8AG-110

or PS42V6AG-110

CBLIO-ISO1-xM

SM23165D-C-AD1

CBLIP-IO-FL (12 Pin)
RA shown, straight also available

CBLIP-CAN-FL (5 Pin)
RA shown, straight also available

Customer Supplied 

USB to Serial Adapter

Class 5 M-Style SmartMotor Cable Connections

D-Style Motors: Demo or Development System

CAUTION: This configuration is designed for development, training or demo
purposes only. It is not intended for use in an industrial (manufacturing) environment.

CBLSM1-DEMO

PWR116V

CBLAC4
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D-Style Motors: RS-232 Through USB

D-Style Motors: RS-232 Through USB

PS24V8AG-110
or PS42V6AG-110

Customer Supplied 

USB to Serial Adapter CBLSM1-xM

Adding a USB to Serial Adapter

For this application, the customer must provide a USB to Serial (FTDI chipset) adapter, which is used on
PCs that don't have a built-in serial port. The adapter allows you to connect from an available USB port on
the PC to the serial interface on the SmartMotor. The adapter simply connects between the USB port and
the serial cable, as shown in the previous figure. These adapters are readily available from computer
supply stores and online shopping websites.

D-Style Motors: RS-232 with Protective Shunt

CBLSM1-xM

CBLDC1

PS24V8AG-110

or PS42V6AG-110

SHUNT42V100W

or SHUNT42V200W
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D-Style Motors: RS-232 Multidrop with Add-A-Motor Cables

D-Style Motors: RS-232 Multidrop with Add-A-Motor Cables

CBLSM1-xM CBLSMADD-xM

PS24V8AG-110 or

PS42V6AG-110

DE Option

The DE (Drive Enable) option allows the controller and drive amplifier to be powered from two separate DC
power supplies. It is highly recommended to use this power option .
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D-Style Motors: CDS Option Schematic

Drive Amp Power Supply:

48 VDC**

DRIVE PWR GND

DRIVE PWR

Control Power Supply:

24 VDC**

CONTROL PWR

CONTROL PWR GND

 11   10    
   9

A1 A2
1  2

3 4 5

 15  14  13  12  11  10   9 

 

 

   8    7    6     5    4    3    2    1  

CN2: 15-PIN D-SUB

PIN# NAME

1 I/O-0

5 I/O-4

2 I/O-1

3 I/O-2

4 I/O-3

9 ENCODER B OUT

6 I/O-5

7 I/O-6

8 ENCODER A OUT

10 RS-232 TRANSMIT

11 RS-232 RECEIVE

13 SIGNAL GND

12 +5VDC OUT

14 CONTROL PWR GND

15 CONTROL PWR

CN1: 7-PIN COMBO

PIN# NAME

5 GND

1 I/O-6

2 +5VDC OUT

3 RS-232 TRANSMIT

4 RS-232 RECEIVE

A1

DRIVE PWR GNDA2

DRIVE PWR

+

−

+

−

T*

T*

L1

L2
AC DC

NOTES:

 * Could be cascaded relays without timer

** Typical DC voltage levels

Shunt

E-Stop

Switch

KT

24 VDC

GND

Protective shunt should be placed between E-stop and motor drive power 
input to suppress Back EMF.

Optional shorting of motor input on dropped drive power provides the most 
protection against Back EMF, and unintended freewheel motion, by employ-
ing dynamic braking to stop the motor.

Relay T is time-delay open; relay K is immediate open; relay K must close 
before relay T to avoid any damage to relay K from SmartMotor in-rush currents.

This circuit is recommended for smoother startup of large switch-mode 
supplies where surge currents may cause noise issues.

K

NOTE: All M-style SmartMotors are designed to allow the use of separate drive and control power
supplies. No special ordering option is needed for those SmartMotors.

D-Style Motors: CDS Option Schematic

This section provides schematics for wiring a Class 5 D-style SmartMotor through the CDS CAN
connection option. This option can be used for Combitronic communications. For details on Combitronic
communications, see Combitronic Communications in the SmartMotor™ Developer's Guide. The option
also allows the integrated brake option to be used with CAN, which is useful for many vertical-axis
applications.

NOTE: The CDS Option is available only on specially equipped D-style SmartMotors. Contact Moog
Animatics for details.

CDS on the DA-15 Connector

A special version of the D-style SmartMotor with the CDS CAN connector option allows CAN bus network
wiring through the DA-15 connector (15-pin D-sub I/O connector shown in the next figure). This is an
advantage when the M-style CAN connector is not desired. The D-style motor with the CDS CAN
connection option can be used as the terminating node. To enable this, a 120 ohm terminating resistor
(shunt) must be placed across pins 10 and 11. For details, see the next figure.
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CDS on the 7W2 Connector (CDS7)

NOTE: Terminating resistors (shunts) must always be used at both ends of a CAN bus network.

Motor as Terminating NodeI/O Connector

Pin Numbers

Trajectory
LED (Bt)

Power/Servo
LED

120 Ohm Terminator Shield Drain

10 CAN Low

 15  14  13  12  11  10   9

   8    7    6     5    4    3    2    1  

11 CAN High

1
5

-p
in

 D
-s

u
b

 M
a

le

15-pin D-sub Male 15-pin D-sub Male 15-pin D-sub Male

1
2
3
4
5
6
7
8

9
10
11
12
13
14
15

1 2 3 4 5 6 7 8 9 1
0

1
1

1
2

1
3

1
4

1
5 1 2 3 4 5 6 7 8 9 1
0

1
1

1
2

1
3

1
4

1
5 1 2 3 4 5 6 7 8 9 1
0

1
1

1
2

1
3

1
4

1
5

10

11

CAN Low

CAN High

PIN DESCRIPTION

All other pins are as 

previously shown.

10 CAN Low

11 CAN High

13 Shield Drain

120 Ohm

Terminator

120 Ohm

Terminator

NOTE: A terminating resistor (shunt) or pass-thru terminator is required at each end of the bus. Bus
must be multi-drop as shown, not a star network. 24V CAN bus power connection is not required at
the motor.

Schematic for CDS Option, D-Style SmartMotor Used as Terminating Node

CDS on the 7W2 Connector (CDS7)

CAUTION:
If you are using the blue-overmolded Add-A-Motor cables (CBLSMCDS-xM) with CAN
bus already in them:
1. Do not create a parallel path between the same motors on the 15-pin (D15) D-sub
connector, as that will cause impedance issues.
2.  Any CAN nodes other than SmartMotors should be placed at the beginning and/or
end of the SmartMotor chain using the 15-pin (D15) D-sub connector. Do NOT
"branch" to them from that connector in the middle of the SmartMotor chain. Branching
is not allowed on the CAN bus.
3.  Be aware of CAN signal wires being present or not in the incoming power/signal
cable to the first 7W2 connector. If also using the 15-pin (D15) D-sub connector to
access the CAN signals, then this could form an unintended branch.
For more information on CAN best practices, visit CAN in Automation at www.can-
cia.org.

Alternatively, the CDS7 option on the D-style SmartMotor allows CDS to be wired through pins 1 and 2 of
the 7-pin D-Sub (7W2) connector as shown in the next figure. The wiring is accomplished through the use
of a single Add-A-Motor cable (PN: CBLSMCDS) that carries Power, RS-232, and CAN bus to the next
motor in the chain. This method allows pins 10 and 11 on the 15-pin D-sub connector to be used as an easy
terminating point on the last motor by simply placing a 120 Ohm terminating resistor (shunt) across those
pins OR installing the Pass-Thru Terminator (PN: CBLSM-TR120) on that connector.
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CDS on the 7W2 Connector (CDS7)

This design not only greatly simplifies motor installation, but also does the same for CAN bus addressing.
With CDS7, the SmartMotor is the first and only single-cable, point-to-point integrated motor to have both
motor-to-motor full communications and control capability, and only single-cable, point-to-point for both
power and communications in general.

As a result:

l When you order the D-series CDS7 SmartMotors and CDS7 Add-A-Motor cables, you get prewired,
instant, full-network capability, and those networked motors are auto-detectable directly from SMI.

l This allows for auto-addressing and ease of reconnection at the next power up.

l Unlike competitive CANopen devices, the CDS7 SmartMotors do not require single-node power up
to set addresses. You can power up all at once, have SMI detect them and set all motor CAN bus
addresses in a single line of code. For details, see Detecting and Addressing the SmartMotors on
page 49.

CDS7 is fully backward compatible with the wiring method described in the previous section. Therefore, all
-CDS7 option SmartMotors can be wired either through the D-sub connector or the 7W2 connector, and
there is no change in motor part numbers for the 7W2 method. The only part change is the cabling used to
connect the motors - refer to the figures, descriptions and part numbers later in this section.

When the SmartMotor is a terminating node on the CAN bus, the 120 Ohm terminating resistor (shunt) must
be wired to pins 10 and 11 of the 15-pin D-sub connector. A 120 Ohm terminating resistor (shunt) is also
required at the beginning of the CAN bus. See the next figures.

For further convenience, a 15-pin pass-through D-sub connector (Pass-Thru Terminator, PN: CBLSM-
TR120) is available that contains a built-in 120 Ohm terminating resistor (shunt). When a SmartMotor is the
terminating node and the 7W2 wiring method is used (described previously), you can simply install the
pass-through connector on the SmartMotor's 15-pin D-sub connector to serve as the terminator.
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CDS on the 7W2 Connector (CDS7)

Motor as 

Terminating Node

Trajectory
LED (Bt)

Power/Servo
LED

7W2 D-sub Female 7W2 D-sub Female 7W2 D-sub Female

1
5

-p
in

 D
-s

u
b

 M
a

le

1
2
3
4
5
6
7
8

9
10
11
12
13
14
15

1 2 3 4 5

1 CAN Low

2 CAN High

5 Shield Drain

11   10   
   9

A1 A2
1 2

3 4 5

1 2 3 4 5 1 2 3 4 5

A1 A2 A1 A2 A1 A2

120 Ohm Terminator

at Bus Controller

(PLC, Host, HMI)

7W2 D-sub Conn.

Pin Numbers

1

2

CAN Low

CAN High

PIN DESCRIPTION

All other pins are as previously 

shown. See the D-Style Con-

nector Pinouts table later in 

this guide for full details.

120 Ohm Terminator
 15  14  13  12  11  10   9

   8    7    6     5    4    3    2    1  

15-Pin D-sub

Connector

10

11

CAN Low

CAN High

PIN DESCRIPTION

All other pins are as previously 

shown. See the D-Style Con-

nector Pinouts table later in 

this guide for full details.

15-pin D-sub Male

1 2 3 4 5 6 7 8 9 1
0

1
1

1
2

1
3

1
4

1
5

CAN Low

CAN High

CAN Low

CAN High

OR 

Incoming CAN on 

15-pin connector 

(NO incoming CAN 

leads on the 7W2)

Incoming CAN on 

7W2 connector

120 Ohm

Terminator

10

11

When motor is an end 

node on CAN bus, install 

this on the 15-pin D-sub:

OR

Pass-Thru

Terminator,

PN: CBLSM-TR120

120 Ohm

Terminator

NOTE: A terminating resistor (shunt) or pass-thru terminator is required at each end of the bus. Bus
must be multi-drop as shown, not a star network. 24V CAN bus power connection is not required at
the motor.

Schematic for CDS7 Option, D-Style SmartMotor Used as Terminating Node

For the above methods, the incoming CAN bus signal is connected to the 7W2 connector OR the 15-pin
connector, and the CDS Add-A-Motor cable (PN: CBLSMCDS-xM) will automatically provide CAN bus,
RS-232 and power wiring in one cable between motors.

The next figure shows how factory cables are used to attach the incoming power and RS-232
communications to the 7W2 connector, and incoming CAN bus signal to the 7W2 connector OR the 15-pin
connector (each method requires different cables).
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CDS on the 7W2 Connector (CDS7)

CBLSMCDS-xM

120 Ohm

Terminator

10

11

When motor is an end 

node on CAN bus, install 

this on the 15-pin D-sub:

Note BLUE connectors 

that differentiate the 

CDS7 cables from 

standard Add-A-Motor 

cables.

120 Ohm

Terminator

Incoming CAN on

15-Pin Connector

There must be NO incoming CAN wires 

on the 7W2 connector.

Incoming RS-232

Incoming Power

CBLSM1-xM

CBLIO5V-xM 

OR

Pass-Thru

Terminator,

PN: CBLSM-TR120

Incoming Power

Incoming RS-232

Incoming CAN on

7W2 Connector

120 Ohm

Terminator

CBLPWRCOM3-xM

OR

NOTE: A terminating resistor (shunt) or pass-thru terminator is required at each end of the bus. Bus
must be multi-drop as shown, not a star network. 24V CAN bus power connection is not required at
the motor.

CDS7 Option Cabling Diagram

Refer to these tables for part numbers and cable lengths:

CDS7
Cable PN

Length
(Meters)

Power/Com
Cable PN

Length
(Meters)

CBLSMCDS-0.3M 0.3 CBLPWRCOM3-xM* 5, 10

CBLSMCDS-0.9M 0.9 CBLSM1-xM** 3, 10

CBLSMCDS-3.0M 3.0 CBLIO5V-xM** 3, 10

CBLSM-TR120
Pass-thru
terminator

CAUTION: As noted by the BLUE con-
nectors, these are NOT the same as the
Add-A-Motor cables shown on page 38, and
they are NOT interchangeable.

*Recommended method
**Optional method

See the cable data on the website or consult the factory for the schematic diagrams.
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M-Style Motors: Connectors and Pinouts

M-Style Motors: Connectors and Pinouts

The next figure provides a brief overview of the connectors and pinouts available on the M-style
SmartMotors. For full details, see Class 5 M-Style Connector Pinouts on page 69.

CAUTION: M-style connectors must be finger tightened only! DO NOT use a wrench
or other tool. Doing so can cause overtightening of the connection, which may
damage the connector and will void the warranty.

PIN

1

2

3

4

5

+24VDC Out

I/O-3 or -Limit

GND-Common

I/O-2 or +Limit

I/O-10

DESCRIPTION

LIMIT INPUTS

PIN

1

2

3

4

5

NC

+V (NC except DeviceNet)

-V (GND-Common)

CAN-H

CAN-L

DESCRIPTION

CANOPEN

1

2

3

4

5

6

7

8

9

10

11

12

I/O-0

I/O-1

I/O-4

I/O-5

I/O-6

I/O-7

I/O-8

I/O-9

Not Fault Out

Drive Enable In

+24VDC Out

GND-Common

PIN

I/Os

1

2

3

4

5

6

7

8

GND-Common

RS-485B CH0

RS-485A CH0

ENC A+ (In/Out)

ENC B- (In/Out)

ENC A- (In/Out)

+5VDC Out

ENC B+ (In/Out)

PIN DESCRIPTION

COMMUNICATION

1

2

3

4

Control Power In 24Vmax

Chassis GND/Earth

GND-Common (req’d. Ground)

Amplifier Power 48Vmax

PIN DESCRIPTION

POWER INPUT

RS-485 serial communication uses a 
voltage differential signal. Appropriate 
terminating resistors should be included 
on the RS-485 network to ensure reliable 
performance.

DESCRIPTION

CANOPEN
RUN LED

12-Pin I/O

4-Pin Power Input

8-Pin

COM Encoder Bus

5-Pin CANopen

(female is standard)
5-Pin

Limit Inputs

CANOPEN
ERROR LED

TRAJECTORY
LED

SERVO-AMPLIFIER
LED

M-Style Connections At A Glance

The next figure provides a quick overview of the cables and connections for the Class 5 M-style motor.

SM23165MT

SM34165MT

PC/RS-485

CBLIP-LIM-FL (5 Pin)

CBLIP-PWR4-FL (4 Pin)

CBLIP-COM-FL (8 Pin)

Separate 24V Control Power

24V - 48V Drive Power 

1
2
3
4

RS232485T

CBLIP-IO-FL (12 Pin)

CBLIP-CAN-FL (5 Pin)

Class 5 M-Style SmartMotor Cable Connections
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M-Style Motors: Power, RS-485 Com and CAN Multidrop

M-Style Motors: Power, RS-485 Com and CANMultidrop

CBLIP-PWR4-FL-xM

CBLIP-PWR4-Y1-xM

CBLIP-CAN-Y1 CBLIP-

TRM120

Pwr

CAN

Com

4
 3
 2
 1

RS232485T

CBLIP-

COM-FL (8 Pin)

CBLIP-

TRF120

Separate 24V

Control Power

24V - 48V

Drive Power

M-Style Motors: Power Multidrop

Separate 24V

Control Power

24V - 48V

Drive Power

CBLIP-PWR4-Y1-xM

15 Amps maximum continuous load

CBLIP-PWR4-FL-xM

This power-connection method would be combined with a communications-connection method. For
example, see the diagrams in the next two sections.
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M-Style Motors: RS-232 to RS-485 Multidrop

M-Style Motors: RS-232 to RS-485 Multidrop

CBLIP-COM-FL (8 Pin)

CBLIP-COM-Y1

4
 3

 2
 1

RS232485T

NOTE: RS-485 serial communications uses a voltage differential signal that requires proper termination
with a 120 ohm resistor across pins 2 and 3 at both ends of the network cable. This complies with
RS-485 standards for biasing to ensure reliable performance. The termination can be created by adding
the resistor to CBLIP-COM-FL Flying Lead cables or to off-the-shelf connectors.

This communications-connection method would be combined with a power-connection method. For
example, see M-Style Motors: Power, RS-485 Com and CAN Multidrop on page 45.
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M-Style Motors: CANopen or DeviceNet Multidrop

M-Style Motors: CANopen or DeviceNet Multidrop

CBLIP-CAN-FL (5 Pin)

CBLIP-CAN-Y1

CBLIP-TRF120

PC, PLC,

etc.

(see NOTE)

NOTE: The bus requires a termination resistor at each end. If the controller device (PC, PLC, etc.) does
not include one, then an external termination resistor must be supplied.

This communications-connection method would be combined with a power-connection method. For
example, see M-Style Motors: Power, RS-485 Com and CAN Multidrop on page 45.
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Understanding the Status LEDs

Understanding the Status LEDs
The Status LEDs provide the same functionality for the D-style and M-style (including IP-sealed)
SmartMotors.

LED Status on Power-up:
• With no program and the travel limit inputs are low (M-style) or high (D-style):

LED 0 will be solid red indicating the motor is in a fault state due to travel limit fault.     

LED 1 will be off.

• With no program and the travel limit inputs are high (M-style) or low (D-style):
LED 0 will be solid red for 500 milliseconds and then begin flashing green.   

LED 1 will be off.

• With a program that disables only travel limits and nothing else:  

LED 0 will be solid red for 500 milliseconds and then begin flashing green.   

LED 1 will be off.

P1 (Power Input)

LED 0

LED 1

P2 (COM 
Encoder Bus)

P3 
(I/O Connector)

P4 
(Limit Inputs)

P5 
(CANopen)

LED 3
LED 2

LED 2:  CAN Bus Network Fault (Red LED)   

Off  No error

Single Flash At least one error 
exceeded limit

Double Flash  Heartbeat or guard error

Solid  Busy off state

LED 3:  CAN Bus Network Status (Green LED)  

Blinking  Pre-operational state 
 (during boot-up)

Solid   Normal operation

Single   Device is in stopped state

Condition
Bt = 0, CAN bus OK
Bt = 1, CAN bus OK

Indication
Trajectory LED = Off
Trajectory LED = Green

Bt refers to Busy Trajectory
status bit. When the motor is
actively pursuing a trajectory, 
that bit will be set to 1.

Bt = 0, CAN bus fault
Bt = 1, CAN bus fault

Trajectory LED = Flashing red
Trajectory LED = Alternating red/green

D-Style Motor CDS Option LED 1 CAN Error Indication:

P4 (EXPANDED I/O option) 

LED 3 

P3 (CANopen option) 

LED 2 

P1 (Main Power)

LED 0 

P2 (I/O Connector)

LED 1 

LED 0:  Drive Status Indicator

Off No power

Solid green Drive on

Flashing green Drive off

Flashing red Watchdog fault

Solid red Major fault

Alt. red/green In boot load; needs firmware

LED 1:  Trajectory Status Indicator
Off Not busy
Solid green Drive on, trajectory in progress
Flashing red CAN error (CDS/CDS7 only)
Alt. red/green CAN error (CDS/CDS7 only)

while trajectory in progress
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Detecting and Addressing the SmartMotors

Detecting and Addressing the SmartMotors
This section describes how to detect and address the motors over the serial network. For details on other
communications methods, see Communication Details in the SmartMotor™ Developer's Guide.

This procedure assumes that:

l The SmartMotor is connected to the computer. For details, see Connecting the System on page 33.

l The SmartMotor is connected to a power source. (M-style motors require separate control and drive
power.) For details, see Understanding the Power Requirements on page 31 and Connecting the
System on page 33.

l The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 26.

Understanding the Detection and Addressing Options

There are three different ways to use the SMI software to find and address the D-style SmartMotors that are
connected to your PC:

l Use the Find Motors button—this method is recommended for first-time communications or when you
don't know the port used to connect the motors. For details, see Using the Find Motors Button on
page 50.

l Use the Detect Motors feature—this method can be used if you know the communications port used
to connect your motors and if your motors may be pre-addressed. For details, see Using the Detect
Motors Feature on page 53.

l Use the Address Motors feature—this method can be used if you know the communications port used
to connect your motors. This method always re-addresses the motors; therefore, if you have pre-
addressed motors connected, their addresses may be changed. For details, see Using the Address
Motors Feature on page 54.

These methods are described in the next sections.

A note about M-style motors:

The M-style SmartMotors only work on RS-485 and, therefore, need to be pre-addressed in nonvolatile
memory such as a user program before being daisy-chained together and detected. To do this, you must:

1. Connect the first motor, address it (typically as motor 1), remove it,

2. Connect the second motor (typically as motor 2), address it, remove it,

3. And so on, until all motors have been pre-addressed.

After all the M-style motors are addressed:

4. Daisy-chain the motors as shown in Connecting the System on page 33.

5. Use the Detect Motors feature. For details, see Using the Detect Motors Feature on page 53.

CAUTION: Do NOT use the Address Motors feature. Doing so will overwrite the
existing motor addresses.

Some notes about motor addressing:

The SmartMotors power up in non-echo state (so no response is sent to the next motor), 9600 KB
communications and a Base address of 0 (zero).
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Using the Find Motors Button

As the system addresses the motors in the RS-232 daisy chain (remember, as discussed in the previous
note, M-style motors use RS-485 and must be pre-addressed), it starts with the first motor in the daisy
chain, sets its address to 1, enables echo, and then puts that motor to sleep. It proceeds to the next motor
in the daisy chain, sets its address to 2, enables echo and puts it to sleep. This process continues until all
the motors in the daisy chain are addressed.

When the motor is addressed, it contains a unique identifier that allows it to respond to commands intended
for that motor and ignore commands intended for other motors. For example, 1RPA reports the position
from motor 1 only; all other motors in the daisy chain ignore the command. However, a global command,
like 0RPA, reports the positions from all motors. For more details on addressing and daisy chaining, see
Daisy Chaining Multiple SmartMotors in the SmartMotor™ Developer's Guide.

Motor addresses are activated and stored in this manner:

l For serial addresses:

l These are stored in the SmartMotor's volatile memory, which means they are lost when motor
power is turned off.

l After setting the address, it goes into effect immediately (do not reboot or perform a system
reset with the Z command; either of these actions will delete the addresses).

l For CAN addresses:

l These are stored in the SmartMotor nonvolatile memory (NVRAM), which means they are
retained when motor power is turned off.

l After setting the address, it doesn't go into effect until the system is restarted or reset.

l The CAN address of a motor is different than the serial address (because they are
communicating on different networks). However, for ease of use, you can "store" the serial
address in the CAN address by entering the command:

CADDR=ADDR

Then, whenever you reset the system (either with the Z command or turning the power off and
back on), you can recall the serial addresses of the motors from the stored CAN addresses,
by entering the command:

0ADDR=CADDR     

Because the CAN address is permanently stored and doesn't change on power off or reset,
this allows you to easily restore specific serial addresses. This method also works for
DeviceNet, PROFIBUS and other industrial networks.

When addressing the motors, you can address serial and CAN in the same command, which means you
can use the serial network to communicate with the CAN bus. The leading number is the serial address; the
number after the colon character is the CAN address. Consider this example:

1RPA:2

The leading "1" is addressing the serial network motor 1; the ":2" is addressing the CAN network motor 2. In
this example, the command is going out on the serial network to motor 1, then out the CAN port to motor 2,
reading motor 2 position info, and then echoing it back to the host from CAN to motor 1 and then serial to
host.

Using the Find Motors Button

The easiest way to locate any connected SmartMotor is to use the Find Motors button (see the next figure).
This method searches every communications port (serial, USB, Ethernet, etc.) on the PC. If you don't know
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Using the Find Motors Button

which port your motor is connected to, this method is the most thorough way to search. However, if you
have many ports, this method can also take a long time.

To begin searching for motors across all ports on the PC, in the Configuration window of the SMI software
interface, click Find Motors. The SMI software begins searching for all SmartMotors connected to the PC.

Find Motors Detecting SmartMotors on the RS-232 Chain

After the motors are detected, the SMI software will address them if needed. The next steps are only used
when the SMI software finds motors that do not have addresses.

To address the motors, click Yes when you see this prompt.

Address the Motors Prompt
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Using the Find Motors Button

A progress bar displays a "Getting motor information" message while the SMI software addresses the
motors. During this process, the SMI software is collecting information on each motor. The information is
the same as that shown in the Motor View window, which can be accessed by selecting the Tools > Motor
View > Info tab:

Motor View Information

After the process has completed, the SMI software shows the found motors in the Configuration window
under the corresponding communications port. Each motor is represented by a motor icon; the motor's
address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Addressed SmartMotor
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Using the Detect Motors Feature

Using the Detect Motors Feature

This method is similar to the Find Motors method, but it searches only the specified communications port
for connected SmartMotors. This is also the recommended method for detecting M-style motors after they
have been pre-addressed and daisy-chained to the communications port.

To use the Detect Motors feature, in the Configuration window of the SMI software, right-click the desired
communications port and select Detect Motors from the menu.

Selecting the Detect Motors Feature

The SMI software begins searching for all SmartMotors connected to the specified communications port. A
progress bar is shown while the SMI software searches for the motors.

After the motors are detected, the SMI software will address them if needed. The next steps are only used
when the SMI software finds motors that do not have addresses.

To address the motors, click Yes when you see this prompt.

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software addresses the
motors. During this process, the SMI software is collecting information on each motor. The information is
the same as that shown in the Motor View window, which can be accessed by selecting the Tools > Motor
View > Info tab:
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Using the Address Motors Feature

Motor View Information

After the process has completed, the SMI software shows the found motors in the Configuration window
under the corresponding communications port. Each motor is represented by a motor icon; the motor's
address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Addressed SmartMotor

Using the Address Motors Feature

This method assumes that there are motors connected to the specified port and will simply address each
one that it finds.
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Using the Address Motors Feature

NOTE: This method will address (or re-address) every motor. If you pre-addressed your motors before
connecting them, those motor addresses could be changed by this process.

To use the Address Motors feature, in the Configuration window of the SMI software, right-click the desired
communications port and select Address RS-232 Chain from the menu.

Selecting the Detect Motors Feature

To address the motors, click Yes when you see this prompt.

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software addresses the
motors. During this process, the SMI software is collecting information on each motor. The information is
the same as that shown in the Motor View window, which can be accessed by selecting the Tools > Motor
View > Info tab:
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Checking and Clearing the Status Bits

Motor View Information

After the process has completed, the SMI software shows the found motors in the Configuration window
under the corresponding communications port. Each motor is represented by a motor icon; the motor's
address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Addressed SmartMotor

Checking and Clearing the Status Bits
NOTE: In addition to the software information in this section, there is context-sensitive help available
within the SMI software interface, which is accessed by pressing the F1 key or selecting Help from the
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Checking and Clearing the Status Bits

SMI software main menu.

The Motor View window is used to view and monitor various motor parameters. It is used in conjunction
with the Terminal window to clear any active overtravel limits.

This procedure assumes that:

l The SmartMotor is connected to the computer. For details, see Connecting the System on page 33.

l The SmartMotor is connected to a power source. (M-style motors require separate control and drive
power.) For details, see Understanding the Power Requirements on page 31 and Connecting the
System on page 33.

l The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 26.

l The SmartMotor has been detected and addressed. For details, see Detecting and Addressing the
SmartMotors on page 49.
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Polling the Motor

Polling the Motor

To view the current state of the status bits, you must poll the motor.

1. Double-click the motor icon to open the Motor View window (see the next figure).

2. Click the Poll button to begin polling data from the motor.

Motor View with Active Overtravel Limits

A SmartMotor with no program and no I/O connections will boot up with active overtravel limits (see the red
status bits numbered 10 through 15 in the previous figure).

The EIGN() command is used to clear these status bits as described in the next section. EIGN stands for:
Enable Inputs as General Use. In the case of EIGN(W,0), the Wmeans a "word" or 16 bits of I/O; the 0
means first word or local I/O. There are only seven local I/O on the D-style motors. Therefore, EIGN(W,0)
sets all seven I/O to general-use inputs.
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Clearing the Overtravel Limits and Fault Bits

To disable (clear) the overtravel limits, enter EIGN(2) and EIGN(3) in the SMI software Terminal
window. This sets I/O 2 (positive overtravel limit) and I/O 3 (negative overtravel limit) as general
inputs/outputs instead of being used as travel limits. To set all status bits in Word 0 as general
inputs/outputs, enter EIGN(W,0).

NOTE: You can either type the command in the white text box or type the command directly in the blue
area of the terminal screen and then click Send or press Enter.

The active and asserted bits are cleared, as shown in the next figures.

EIGN Command Entered Active and Asserted Bits Cleared

To clear the historical fault bits, enter ZS. All remaining fault bits are cleared, as shown in the next figures.

ZS Command Entered Remaining Bits Cleared
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Moving the SmartMotor

Moving the SmartMotor
NOTE: In addition to the software information in this section, there is context-sensitive help available
within the SMI software interface, which is accessed by pressing the F1 key or selecting Help from the
SMI software main menu.

The SMI software contains a Torque mode that is used to test the motor response and ensure the drive is
operating properly.

This procedure assumes that:

l The SmartMotor is connected to the computer. For details, see Connecting the System on page 33.

l The SmartMotor is connected to a power source. (M-style motors require separate control and drive
power.) For details, see Understanding the Power Requirements on page 31 and Connecting the
System on page 33.

l The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 26.

l The SmartMotor has been detected and addressed. For details, see Detecting and Addressing the
SmartMotors on page 49.

l The Drive Enable input on the M-series motor must be connected and activated with 24V. For the
input location, see M-Style Motors: Connectors and Pinouts on page 44.

l The overtravel limits and fault bits have been cleared. For details, see Checking and Clearing the
Status Bits on page 56.

Making the Motor Move

WARNING: The larger SmartMotors can shake, move quickly and exert great force.
Therefore, proper motor restraints must be used, and safety precautions must be
considered in the workcell design (see Other Safety Considerations on page 8).

To make the SmartMotor move:

1. In the Terminal window, select the tab that matches the communications channel to which your
motors are connected. To do this, look at the Configuration window, find the channel where the
motors are listed and click that tab name in the Terminal window.

Tab Selected that Matches the Communications Channel

NOTE: If you do not have the correct tab selected, the commands you enter will not go to the
motors and there will be no response.
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Setting and Reporting Torque

2. Enter these commands in the Terminal window:

You should immediately see the motor shaft moving in the positive direction (clockwise, when
looking at the end of the motor shaft). If the motor does not respond to the commands, see
Troubleshooting on page 73 for troubleshooting tips.

NOTE: Macros (shortcut keys) can be used to simplify entry of frequently-used commands. For
details, see Macros in the SmartMotor™ Developer's Guide.

3. After you have observed the motor shaft turning, enter the X command to decelerate the motor to a
stop.

Setting and Reporting Torque

The commands in this section are related to the previous motion procedure. For more details on these
commands, see the SmartMotor™ Developer's Guide.

MT (Mode Torque)

MT sets the mode of operation to torque mode. In this mode, the SmartMotor shaft applies a torque
independent of position. For more details, see Torque Mode in the SmartMotor™ Developer's Guide.

T=formula (Set Target Torque)

T can be set to any value from -32767 to +32767, which represents -99.99% to +99.99% PWM (pulse-width
modulation) commanded.

RTRQ (Report Actual Torque)

Enter RTRQ at the Terminal window to report the commanded torque from the trajectory generator.

Note that RTRQ typically reports a value that's one less than the T value. In the previous example, T=3000,
but RTRQ reports 2999. The value returned by TRQ (and RTRQ) will typically be one less than the T
(torque) value due to internal calculations. It may also be reduced in cases where the motor’s output is in
limitation. TRQ represents the output effort of the motor in both MT (torque mode) and servo modes (MV,
MP, etc.). Therefore, it provides a seamless transfer across those modes without causing a ripple or bump
in force to the load.

TS (Set Torque Slope)

The TS command defines how fast the processor applies a change in torque. For an example of the
TS command, see the Chart View Example in the SmartMotor™ Developer's Guide.

Torque slope can range from -1 to 2147483647 (default). At a value of 65536, the processor changes
torque by a value of 1 for each PID sample. The default sample rate is 8000; you can view the current
sample rate with the RSAMP command.
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Checking the Motor Position

Checking the Motor Position
There are several ways to check the motor position:

l Report the position using commands from the Terminal window

l View the position in the Motor View tool

These two methods are described in the next sections. You can also view the position in the Monitor or
Chart View software tools. For details, see SMI Software Features in the SmartMotor™ Developer's Guide.

This procedure assumes that:

l The SmartMotor is connected to the computer. For details, see Connecting the System on page 33.

l The SmartMotor is connected to a power source. (M-style motors require separate control and drive
power.) For details, see Understanding the Power Requirements on page 31 and Connecting the
System on page 33.

l The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 26.

l The SmartMotor has been detected and addressed. For details, see Detecting and Addressing the
SmartMotors on page 49.

l The overtravel limits and fault bits have been cleared. For details, see Checking and Clearing the
Status Bits on page 56.

Viewing the Motor Position with a Report Command

To report the motor position, in the Terminal window, issue the RPA (Report Position Actual) command:

RPA

The terminal responds with the current position of the motor:

RPA 3593657

NOTE: The position is reported on the same line as the command; there is no line feed or carriage
return for "report" commands.

The RPA command reports the actual motor position at the time the command was issued. Therefore, it is
just a "snapshot"—if the motor is moving, the reported position is not dynamically updated.

Viewing the Motor Position with the Motor View Tool

The Motor View tool provides another way to view the motor position. The advantage of using this tool is
that the position is dynamically updated when the motor is moving.
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Viewing the Motor Position with the Motor View Tool

To open the Motor View tool, from the SMI software Configuration window, right-click the motor you want to
view and select Motor View from the menu.

Opening the Motor View Tool

After the Motor View window opens, click the Poll button to begin polling (getting information from) the
motor. After polling begins, the motor position is shown in the Position box.
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Viewing the Motor Position with the Motor View Tool

Motor View Tool Showing the Motor Position
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Connectors, Pinouts and Examples

Connectors, Pinouts and Examples
This chapter provides information on the Class 5 SmartMotor connector pinouts and specifications for both
D-style and M-style motors. It also provides example I/O connection diagrams. For information on
connecting the motors, see Connecting the System on page 33.

Class 5 D-Style Connector Pinouts 66

Class 5 D-Style I/O Connection Examples 67

Class 5 M-Style Connector Pinouts 69

Class 5 M-Style I/O Connection Examples 70
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Class 5 D-Style Connector Pinouts

Class 5 D-Style Connector Pinouts
This table shows the pinouts for the connectors on the Class 5 D-style SmartMotors.

PIN MAIN POWER P1
1 I/O – 6 GP, Index Input or “G” Command 25 mAmp Sink or Source 

10 Bit  0-5 VDC A/D
Redundant connection on 
I/O connector 7W2 Combo

D-Sub Connector2 +5 VDC Out 50 mAmps Max (total)
3 RS-232 Transmit
4 RS-232 Receive
5 Common Ground (typ. SIG Ground)
A1 Main Power
A2 Common Ground (req’d. POWER Ground)

PIN I/O CONNECTOR (5V TTL I/O) P2
1 I/O – 0 GP or Encoder A or Step Input 1.5 MHz Max as Encoder 

or Step Input

P2 DB-15 D-Sub Connector

2 I/O – 1 GP or Encoder B or Direction Input 1.5 MHz Max as Encoder 
or Direction Input

3 I/O – 2 Positive Over Travel or GP

4 I/O – 3 Negative Over Travel or GP

5 I/O – 4 GP, IIC (SDA) or 
RS-485 A (Com ch. 1)

6 I/O – 5 GP, IIC (SCL) or 
RS-485 B (Com ch.1)

7 I/O – 6 GP, Index Input or “G” Command Redundant connection on 
Main Power Connector

8 Phase A Encoder Output
9 Phase B Encoder Output
10 RS-232 Transmit; For -CDS/7, CAN-L only
11 RS-232 Receive; For -CDS/7, CAN-H only
12 +5 VDC Out 50 mAmp Max (total)
13 Common Ground (typ. SIG Ground)
14 Common Ground
15 Main Power: +20-48 VDC If DE Option, Control Power

separate from Main Power 

PIN CAN bus Connection: P3

1 NC NC

2 +V NC except DeviceNet

3 -V (ground, not common)

4 CAN-H 1 MBaud Max

5 CAN-L 1 MBaud Max

PIN Isolated 24 VDC I/O Connector Max Load (sourcing) P4
1 I/O – 16 GP

M12 12-Pin
Female End View

2 I/O – 17 GP
3 I/O – 18 GP
4 I/O – 19 GP
5 I/O – 20 GP
6 I/O – 21 GP
7 I/O – 22 GP
8 I/O – 23 GP
9 I/O – 24 GP
10 I/O – 25 GP
11 +24 Volts Input 18-32 VDC
12 Ground-I/O (not common)

P3 5-Pin CAN
(female is standard) 

P4 12-Pin Expanded I/O Connector

P1 7-Pin Combo
D-Sub Power 
& I/O

P2 15-Pin D-Sub I/O

M12 5-Pin

 15  14  13  12  11  10   9

   8    7    6     5    4    3    2    1  

11   10   
   9

A1 A2
1 2

3 4 5

Female

Notes:

Input current < 10 mA

CAN Ground Isolated

Notes:

Notes:

NOTE: All specifications are subject to change without notice. Consult the factory for the latest information.

Notes:

NOTE: I/O ports input impedance = 5 kohm (5 kohm pull-up resistor)

CAUTION: Pins 14 and 15 are intended for use with 
DE series motors for control power only. Attempt-
ing to power a non-DE motor through those pins, as 
main servo-drive power, may result in immediate 
damage to the electronics, which will void the war-
ranty.

CAUTION: Connectors P3 and P4 must be finger 
tightened only! DO NOT use a tool. Doing so can cause 
overtightening of the connection, which may damage 
the connector and will void the warranty. 

Isolated

Must be Main Power Ground

Specifications:

Specifications:

NOTE: These motors can operate on power down to +20 VDC, but it is not recommended due to greatly reduced performance —
optimum performance is achieved at 48 VDC.

See NOTE

These I/O ports also 
support analog input

300 mAmps 

150 mAmps

Com ch. 0

24 mAmp Sink or Source

25 mAmp Sink or Source
10 Bit  0-5 VDC A/D

115.2 KBaud Max

115.2 KBaud Max

115.2 KBaud MaxCom ch. 0

+5 VDC Out; For -CDS7, CAN-H only

I/O – 6 GP, Index Input or “G” Command;
For -CDS7, CAN-L only

 +24-48 VDC

Moog Animatics Class 5 SmartMotor™ Installation and Startup Guide, Rev. M

Page 66 of 76



Class 5 D-Style I/O Connection Examples

Class 5 D-Style I/O Connection Examples
The next figures show I/O connection examples for the Class 5 D-Style motors. Also, refer to Class 5
D-Style Connector Pinouts on page 66 for connector specifications.

1

2

3

4

5

6

7

8

9

11

12

13

14

15

10

Port 0 (Enc A or Step Input)

Port 1 (Enc B or Dir Input)

Port 2 (Pos or Right Limit)

Port 3 (Neg or Left Limit)

Port 5 (AniLink C/RS-485 B)

Port 6 (G, Index Capture, RS-485 COM 0)

Enc A Out

Enc B Out

RS-232 Tx

RS-232 Rx

+5 VDC Out

Signal GND

Power GND

Servo Power (+)

Gnd 5VGnd
B A

NPN
Sense

Port 4 (AniLink D/RS-485 A)

Optical
Encoder

Quadrature Signals

Pos / Right Limit (Dry Switch)

Neg / Left Limit (Dry Switch)

NPN Switch

Momentary Switch

SMARTMOTOR 15-PIN D-SUB I/Os
NOTE: I/O is Sinking type (NPN)

Digital I/O

Analog Input

Counter or Comm +5V

5k

Input 0

5.6V

100

CPU

Knowing the SmartMotor's internal schem-
atic can be useful when designing external
interfaces. SmartMotor I/O is logic 0 for
voltages below 1.2V and logic 1 for
voltages above 3.0V. Note that logic states
for voltages between these are unpre-
dictable.

NOTE: For improved linearity of analog potentiometers, select one that is less than or equal to the
motor's internal pull-up resistor. For example, if the motor's pull-up resistor is 5 kohm, use a
potentiometer that is no greater than 5 kohm.
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SMARTMOTOR AD1 OPTION I/Os

NOTE: I/O is Sourcing type (PNP)

4

I/O-18 GP

I/O-19 GP

3

2

5

I/O-17 GP

I/O-20 GP

+24VDC Power Supply 

(User Supplied)

DC- (COM)DC+

6 I/O-21 GP

7 I/O-22 GP

8 I/O-23 GP

9 I/O-24 GP

10 I/O-25 GP

11 +24VDC IN

12 Ground

1 I/O-16 GP

OUT 0

OUT 2

OUT 4

OUT 6

OUT 8

OUT 10

OUT 12

OUT 14

DC COM

+VDC

OUT 1

OUT 3

OUT 5

OUT 7

OUT 9

OUT 11

OUT 13

OUT 15

CR

CR

CR

CR IN 0

IN 2

IN 4

IN 6

DC COM

IN 1

IN 3

IN 5

IN 7

Input and output blocks are for

Allen Bradley CompactLogix PLC

DC+

DC- (COM)

DC+

.  .  .

A/B Output Block
A/B Input Block

Output

Output

Output

Output

Input

Input

Input

Input

Input

SMARTMOTOR AD1 OPTION I/Os

NOTE: I/O is Sourcing type (PNP)

4

I/O-18 GP

I/O-19 GP

3

2

5

I/O-17 GP

I/O-20 GP

+24 VDC 

Power Supply 

(User Supplied)

DC- (COM)

DC+

6 I/O-21 GP

7 I/O-22 GP

8 I/O-23 GP

9 I/O-24 GP

10 I/O-25 GP

11 +24VDC IN

12 Ground

1 I/O-16 GP

–  LOAD ++

–

+

–

Output

Input

Input

Input

Input

–  LOAD +
Output

–  LOAD +
Output

–  LOAD +
Output

NOTE: Be sure that voltage drop across the potentiometer is appropriate for the rated wattage of the
potentiometer, i.e., Watts = Voltage2 / Ohms. For example, at 24 VDC and using a 10 kohm pot: V2/R =
0.06 Watts.
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Class 5 M-Style Connector Pinouts

Class 5 M-Style Connector Pinouts
This table shows the pinouts for the connectors on the Class 5 M-style SmartMotors.

PIN Main Power Notes: P1
1 Control Power In +12.5V Min, 32V Max Also Supplies I/O

M16 4-Pin Male
2 Chassis Ground
3 Common Ground

(Req’d. Ground)
Nonisolated

4 +12.5V Min, 48V Max
PIN Communications Connector Notes: P2
1 Control, Com, I/O and Amp Ground Common Ground Nonisolated

M12 8-Pin
Female End View

2 RS-485 B, Com ch. 0
3 RS-485 A, Com ch. 0
4 Encoder A+ Input/Output 1.5 MHz Max as Encoder 

or Step Input
5 Encoder B- Input/Output 1.5 MHz Max as Encoder 

or Direction Input
6 Encoder A- Input/Output 1.5 MHz Max as Encoder 

or Step Input
7 +5V Out 250 mA Max
8 Encoder B+ Input/Output 1.5 MHz Max as Encoder

or Direction Input

PIN 24V I/O Connector Notes: P3
1 I/O – 0  GP

M12 12-Pin
Female End View

2 I/O – 1  GP

3 I/O – 4  GP

4 I/O – 5  GP or Index

5 I/O – 6  GP or “G” Command

6 I/O – 7  GP

7 I/O – 8  GP or Brake Line Output

8 I/O – 9  GP

9 Not Fault Out

10 Drive Enable Input

11 +24 Volts Out 12.5V Min, 28V Max

12 Ground Common Common Ground Nonisolated

PIN 24V I/O Connector Notes: P4
1 +24 Volts Out From Control Pwr In M12 5-Pin

Female End View2 I/O – 3 GP  -Limit

3 Ground Common Ground Nonisolated
4 I/O – 2 GP  +Limit
5 I/O – 10 GP

PIN CAN Connector Notes: P5
1 NC NC
2 +V NC except DeviceNet
3 -V (ground) Common Ground Nonisolated
4 CAN-H
5 CAN-L

P4
5-Pin
Limit Inputs

P2
8-Pin
COM Encoder Bu s

P1 4-Pin Power Input

P5
5-Pin CANopen
(female is standard)

P3
12-Pin I/O

LED 2LED 3

LED 1

LED 0

M12 5-Pin
Female (std) Male (opt)Input current < 10 mA

150 mAmps Max

NOTE: All specifications are subject to change without notice. Consult the factory for the latest information.

NOTE: I/O ports input impedance > 10 kohms

Note: I/O ports input impedance > 10 kohms

CAUTION: Exceeding 32 VDC into control power on any 
of the +24V pins may cause immediate damage to the 
internal electronics. Exceeding a sustained voltage of 
48V to pin 4 of the P1 Power Input may cause immedi-
ate damage to the internal electronics. Exceeding 
these voltage limits will void the warranty.

CAUTION: M-style connectors must be finger tightened 
only! DO NOT use a tool. Doing so can cause overtight-
ening of the connection, which may damage the con-
nector and will void the warranty. 

Configurable (supports 
analog in)

Control, Com, I/O and Amplifier Ground

Specifications:

Specifications:

Specifications:

Specifications:

Specifications:

Chassis Ground Only Not Connected to Common

Amplifier Power In Powers Amplifier Only

Configurable as Encoder
Output

Configurable as Encoder
Output
Configurable as Encoder
Output

Configurable as Encoder
Output

150 mAmps Max

300 mAmps Max

150 mAmps Max

115.2 KBaud Max

These I/O ports also 
support analog input

150 mAmps Max

1 MBaud Max

Configurable (supports 
analog in)
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Class 5 M-Style I/O Connection Examples

Class 5 M-Style I/O Connection Examples
The next figures show I/O connection examples for the Class 5 M-Style motors. See the Notes at the end of
this section. Also, refer to Class 5 M-Style Connector Pinouts on page 69 for connector specifications.

1

4

I/O 3 or - Limit

I/O 2 or + Limit
Pos / Right Limit (Dry Switch)

Neg / Left Limit (Dry Switch)

5-Pin Limit Inputs

2

PIN

1
2
3
4
5

+24VDC Out
I/O-3 or -Limit
GND-Common
I/O-2 or +Limit
I/O-10

DESCRIPTION

LIMIT INPUTS

24VDC Out (see Notes)

1

2

3

4

5

6

7

8

GND-Common

RS-485B CH0

RS-485A CH0

ENC A+ (In/Out)

ENC B- (In/Out)

ENC A- (In/Out)

+5VDC Out

ENC B+ (In/Out)

PIN DESCRIPTION

COMMUNICATION

5

6

Enc B-

Enc A-

8-Pin COM / Encoder Bus

1 GND Common

Gnd 5VGnd
B A

Optical
Encoder

7 +5 VDC Out (see Notes)

5

6 Enc A-

Enc B-Gnd 5VGnd
B A

Optical
Encoder

1 GND Common

4 Enc A+

8 Enc B+

Single Ended Sinking Output

Single Ended Sourcing Output

7 +5 VDC Out (see Notes)

5

6 Enc A-

Enc B-

1 GND Common

4 Enc A+

8 Enc B+

Differential Output

A-
B- A+Gnd

B+

Optical
Encoder

8 Enc B+

4 Enc A+

12-Pin I/O 8-Pin COM

5-Pin Limit

Moog Animatics Class 5 SmartMotor™ Installation and Startup Guide, Rev. M

Page 70 of 76



Class 5 M-Style I/O Connection Examples

2

5

11

I/O-1

I/O-6

+24VDC Out 
(see Notes)

Momentary Switch

PNP
Sense

I/Os

PNP Switch 1

2

3

4

5

6

7

8

9

10

11

12

I/O-0 GP

I/O-1 GP

I/O-4 GP

I/O-5 GP or Index

I/O-6 GP or G Cmd

I/O-7 GP

I/O-8 GP or Brake Line Output 

I/O-9 GP

Not Fault Out

Drive Enable In

+24 VDC Out

GND-Common

PIN

I/Os

DESCRIPTION

NOTE: I/O is Sourcing type (PNP)

4

3

2

5

6

7

8

9

10

11 +24VDC OUT

12 Ground

1

–  LOAD +
+
–

+

–

1

2

3

4

5

6

7

8

9

10

11

12

I/O-0 GP

I/O-1 GP

I/O-4 GP

I/O-5 GP or Index

I/O-6 GP or G Cmd

I/O-7 GP

I/O-8 GP or Brake Line Output 

I/O-9 GP

Not Fault Out

Drive Enable In

+24 VDC Out

GND-Common

PIN

I/Os

DESCRIPTION

Analog Output 
Sensor

Analog
Potentiometer

Class 5 M-Style Analog Pot and Sensor

Output

Input

Input

Input

Input

NOTE: Be sure that voltage drop across the potentiometer is appropriate for the rated wattage of the
potentiometer, i.e., Watts = Voltage2 / Ohms. For example, at 24 VDC and using a 10 kohm pot: V2/R =
0.06 Watts.

NOTES:

I/O TYPE

The Class 5 M-Style motor I/O is Sourcing type (PNP).

DRIVE ENABLE

The Drive Enable input (pin 10) must be satisfied in order for the motor to turn.
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Class 5 M-Style I/O Connection Examples

24 VOLTS DC POWER

l If you supply control power on the main connector, the I/O connector should not be a feed through
for loads, and the I/O devices should be sourced from an external power supply.

l Loads on specific outputs are allowed (when within the described limits).

DIFFERENTIAL ENCODER

The Differential Encoder inputs use the standard RS-485 chipset:

l If a true differential output TTL encoder is used, just wire A and B signals as labeled.

CAUTION: NO differential encoder signals higher than 5V TTL should be used!

RS-485

Note: The 620 ohm biasing resistors are not needed in most cases but recommended if there are
communication problems.

+5 VDC PIN

The +5 VDC pin can only source 50 mA and is meant for RS-485 biasing only. If it is used to power an
external 5V TTL encoder, the device must not draw more than 50 mA max.
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Troubleshooting

Troubleshooting
This section provides troubleshooting information for common problems. For additional support resources,
see: http://www.animatics.com/support.html.

Issue Cause Solution
Communication and Control Issues

Motor control power light does
not illuminate.

Control power is off, disconnected
or incorrectly wired.

Check that control power is connected to the proper pins
and turned on. For connection details, see Connecting the
System on page 33.

Motor has routed drive power
through drive-enable pins.

Ensure cabling is correct and drive power is not being
delivered through the 15-pin connector.

Motor is equipped with the DE
option.

To energize control power, apply 24-48 VDC to pin 15 and
ground to pin 14.

Motor does not communicate
with SMI.

Transmit, receive or ground pins
are not connected correctly.

Ensure that transmit, receive and ground are all connected
properly to the host PC.

Motor program is stuck in a
continuous loop or is disabling
communications.

To prevent the program from running on power up, use the
Communications Lockup Wizard located on the SMI
software Communications menu.

Motor disconnects from SMI
sporadically.

COM port buffer settings are too
high.

Adjust the COM port buffer settings to their lowest values.
This is done In the Windows Device Manager> Advanced
Settings dialog box for the associated COM port driver.

Poor connection on cable from
motor to PC.

Check the cable connections and/or replace it.

Power supply unit (PSU)
brownout.

PSU may be undersized for the application, which causes it
to brown-out during motion. Make moves less aggressive,
increase PSU size or change to a linear unregulated power
supply.

Motor stops communicating
after power reset, requires
redetection.

Motor does not have its address
set in the user program.
NOTE: Serial addresses are lost
when motor power is off or reset.

Use the SADDR or ADDR= command within the program to
set the motor address. If there is more than one motor in a
serial daisy chain, ensure the ECHO command is in the
downloaded program.

Red PWR SERVO light
illuminated.

Red LED indicates the drive stage
is OFF. This may be due to never
having been turned on yet, or a
critical shaft protection fault.

To discover the source of the fault, use the Motor View tool
located on the SMI software Tools menu.

Motor doesn't turn. Faults not cleared and/or drive
enable not satisfied.

Clear faults (see Checking and Clearing the Status Bits on
page 56).
Satisfy the drive enable input (see M-Style Drive Enable
Power on page 33).

Common Faults

Bus voltage fault. Bus voltage is too high for
operation.

Check servo bus voltage. Check for excessive regenerative
energy from motor due to no/insufficient shunt resistor.

Bus voltage is too low for
operation.

If motor uses the DE power option (separate drive and
control power supplies), ensure that both power supplies
are connected and are sized correctly for the motor.

Overcurrent occurred. Motor intermittently drew more
than its rated level of current.
Does not cease motion.

Consider making motion less abrupt with softer tuning
parameters or lower acceleration profiles.

Excessive temperature fault. Motor has exceeded internal PCB
temperature limit of 85°C. Motor
will remain unresponsive until it
cools down below 80°C.

Motor may be undersized or ambient temperature is too
high. Check motor sizing for the application in terms of
continuous rating. Consider adding heat sinks or forced air
cooling to the system.
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For Further Information...

Issue Cause Solution
Excessive position error. The motor's commanded position

and actual position differ by more
than the user-supplied error limit.

Increase error limit, decrease load or make movement less
aggressive. Also, ensure you are not voltage limited for the
torque at speed required. If running from less than 48 VDC,
check ratings for lower bus voltages and ensure the motor
is within required torque capacity.

Motor faults on position error
only after a certain amount of
time.

Motor sized incorrectly. Check motor sizing for the application in terms of
continuous rating. Also, ensure you are not voltage limited
for the torque at speed required. If running from less than
48 VDC, check ratings for lower bus voltages and ensure
the motor is within required torque capacity.Motor is not accurately

corresponding to trajectory.

Historical positive/negative
hardware limit faults.

A limit switch was tripped in the
past.

Clear errors with the ZS command.

Motor does not have limit switches
attached.

Configure the motor to be used without limit switches by
setting their inputs as general use.

No "Drive Ready" state. Absolute Encoder Battery fault. Check Status Word 6, bit 12.

Programming and SMI Issues

Several commands not
recognized during compiling.

Compiler default firmware version
set incorrectly.

Use the Compiler default firmware version option in the SMI
software Compile menu to select a default firmware version
closest to the motor's firmware version. In the SMI software,
view the motor's firmware version by right-clicking the
motor and selecting Motor Properties.

For Further Information...
Now that your SmartMotor is installed and operating, the next step is to learn about its features, commands
and programming in order to create a useful application.

Information on SMI software features, SmartMotor programming, communications, motion control and
more is provided in the SmartMotor™ Developer's Guide. That guide also includes a complete SmartMotor
command reference, and an Appendix of other related topics that are useful during application
development.
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